Contents

1 Introduction ............................................................................................................................................. 1
  1.1 Specification ................................................................................................................................. 1
  1.2 About ScopeImage 9.0 .................................................................................................................. 2
  1.3 Assemble ......................................................................................................................................... 3

2 Installation Instruction ......................................................................................................................... 4
  2.1 Minimum System Requirements .................................................................................................. 4
  2.2 Common sense about hardware and software ................................................................................ 5
  2.3 Install Introduction ......................................................................................................................... 5
  2.4 Attention before Using ................................................................................................................... 8

3 Workspace ............................................................................................................................................... 9
  3.1 Menu ................................................................................................................................................ 9
  3.2 Tools Bar ......................................................................................................................................... 9
  3.3 Camera Pane .................................................................................................................................. 10
  3.4 Auto focus pane (Optional) .......................................................................................................... 12

4 Operation ............................................................................................................................................... 13
  4.1 Video Mode ..................................................................................................................................... 13
    4.1.1 Video Preview ........................................................................................................................... 13
    4.1.2 Video Control ............................................................................................................................ 14
    4.1.3 Color Adjust ................................................................................................................................ 15
    4.1.4 Capture ...................................................................................................................................... 17
  4.2 Auto focus pane (Optical) .............................................................................................................. 19
  4.3 Image Mode ..................................................................................................................................... 22
    4.3.1 Image Process ............................................................................................................................ 22
    4.3.2 Image Flip ................................................................................................................................... 23
    4.3.3 Image Measurement ................................................................................................................... 24
    4.3.4 Image Calibration ....................................................................................................................... 26
  4.4 Full Screen Mode .............................................................................................................................. 32

5 Trouble Shooting .................................................................................................................................. 33
  5.1 Problem and Solution ...................................................................................................................... 33
  5.2 How to update driver ....................................................................................................................... 34
Thank you for purchasing our microscope product. To avoid any misuse and damage, please read the operation instruction carefully before operation. This is a color USB2.0 digital image system that captures microscope images and displays real-time live video on your PC screen. It comes with a high-resolution digital camera, built-in reduction lens, user-friendly software, and adapters for all sizes of microscopes.

1 Introduction

1.1 Specification

<table>
<thead>
<tr>
<th>Type</th>
<th>1.3M pixel</th>
<th>3.0M pixel</th>
<th>5.0M pixel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Sensor</td>
<td>1/2.5&quot;CMOS</td>
<td>1/2.5&quot;CMOS</td>
<td>1/2.5&quot;CMOS</td>
</tr>
<tr>
<td>Valid Pixel</td>
<td>1280×1024</td>
<td>2048×1536</td>
<td>2592×1944</td>
</tr>
<tr>
<td>Digital Output</td>
<td>24–bit (color)</td>
<td>24–bit (color)</td>
<td>24–bit (color)</td>
</tr>
<tr>
<td>Image Format frame rate</td>
<td>1280×1024 6 f/s</td>
<td>2048×1536 4 f/s</td>
<td>2592×1944 2.5 f/s</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>0.53 v@550um/lux/s</td>
<td>0.53 v@550um/lux/s</td>
<td>0.53 v@550um/lux/s</td>
</tr>
<tr>
<td>SNR</td>
<td>40dB</td>
<td>40dB</td>
<td>40dB</td>
</tr>
<tr>
<td>Dynamic Range</td>
<td>66.5dB</td>
<td>66.5dB</td>
<td>66.5dB</td>
</tr>
<tr>
<td>Connecting Mode</td>
<td>Insert it into Eyepiece Tube of Microscope Directly or Using Standard C Mount</td>
<td>Insert it into Eyepiece Tube of Microscope Directly or Using Standard C Mount</td>
<td>Insert it into Eyepiece Tube of Microscope Directly or Using Standard C Mount</td>
</tr>
<tr>
<td>Image Output</td>
<td>USB2.0, Directshow and Twain</td>
<td>USB2.0, Directshow and Twain</td>
<td>USB2.0, Directshow and Twain</td>
</tr>
<tr>
<td>Working Temperature</td>
<td>-30°C ~ 70°C</td>
<td>-30°C ~ 70°C</td>
<td>-30°C ~ 70°C</td>
</tr>
<tr>
<td>Windows System</td>
<td>Windows 2000/XP/Vista/Win 7 32bit or 64bit</td>
<td>Windows 2000/XP/Vista/Win 7 32bit or 64bit</td>
<td>Windows 2000/XP/Vista/Win 7 32bit or 64bit</td>
</tr>
<tr>
<td>Mac OS X (Apple)</td>
<td>Support, driver free.</td>
<td>Support, driver free.</td>
<td>Support, driver free.</td>
</tr>
</tbody>
</table>

- With High Resolution chip, Providing High Quality Image and Widely Used in Academic and Medical Field for High Precision and Resolution Image Capturing and Processing;
- Very convenient to Use, just insert it into Eyepiece Tube or Top Tube of Trinocular Head;
- By USB2.0, getting Real-time and Non-compressing Video Data and Capturing Image Directly;
In Mac operating systems, it is driver free, and with the Mac's own native image software, like “iChat”, and “PhotoBooth”, you can take pictures and record video with the camera.

1.2 About ScopeImage 9.0

High resolution image processing software is especially designed for digital microscope; it has friendly operation interface, stable performance and powerful function, very easy to operate. And can be widely used in various optical micro fields, such as teaching, researching, electronic checking and so on.

Fig1.1 The operation interface of the software

ScopeImage 9.0 Features

ScopeImage 9.0 is image-processing software professionally designed for digital microscope. It allows you to view, capture, edit, record, zoom, measure, and process microscope images. Specific features include as the follows:

1) Active image preview, freezing preview, fit to window preview, real preview, full screen preview... various preview modes make you preview the active images with great ease.

2) Convenient color adjustment of the active image, containing brightness, contrast, saturation, RGB value, auto exposure and so on, very convenient to adjust the color during previewing.
3) Special design color database, we can associate the parameters of the color to the database, and can store or delete the color scheme.

4) Various image measurement tools, including line, angle, rectangle, polygon and circle, can move, delete or set the color of the objects, add text on the image. And you can also burn all the objects into the image for further using.

5) Automatic measurement and real-time measurement result display.

6) Basic image operations like other similar software are included in the Image menu. You can adjust the image at ease.

7) Image flip function, include horizontal flip and vertical flip of the active image, and rotate 90 degree, 180 degree, 270 degree or any angle degree of the captured image.

8) Image Zoom: Contain image zoom in, zoom out, 1:1.

9) Support Multilanguage, including: Arabic, Chinese, English, French, German, Japanese, Polish.

The follow is the image captured by the camera as example.

1.3 Assemble

Please assemble the accessories as follows:
Optional (choose to buy): 0.01mm or 0.1mm Calibration Slide.

2. Installation Instruction

2.1 Minimum System Requirements

System Requirements
- Operating System Windows 2000/XP/Vista/Win 7 32bit or 64bit.
- Windows 2000 need to install the DirectX9.0 to obtain better picture quality.
- Video adapter supports 24bit color or more and 1280*1024 or 1024*768 resolution
- CPU with 2.0GHz or more
- System Memory 256MB or more, Display Memory 128MB or more
- USB2.0 interface
- Hard Disk Space 1GB for installation plus additional space for captured images

Since video processing is hardware intensive, a faster computer with a fast hard disk drive and extra memory will yield better results.

### 2.2 Common sense about hardware and software

Here introduce the basic sense of digital camera. Generally speaking, it includes two sections: one is the hardware **driver**; the other is the software **application**.

The driver is combining with the hardware (the chip of the digital camera) closely. The computer can operate the hardware, only when it has installed the right driver. Say in brief, it’s the question of can and can not.

The application, as we know the Scopelimage 9.0. The application perform the task that the users need; it’s the question of how to operate.

**Connect the Camera to the Computer**

Connect USB devices to a computer while the computer is turned on. This “hot plug” capability is a convenient feature of USB products. To connect the camera to a computer, do as follows:

Plug one end of the USB cable to an open USB port on your computer, and the other end to the camera. When you connect it rightly, the computer’s Operating System should recognize it, and pops up a found new hardware dialog. The camera’s RED LED should on. Please follow the clue to install the driver and software of the camera device.

**Attention:**

Please use the same USB2.0 port; otherwise you may need to update your driver again to make the camera work normally.

**Before installation**

Please link the digital microscope to the computer with the USB2.0 cable before you run the setup.

There’re a few differences among the camera installation in Windows operation systems, here shows the introduction in Windows XP for an example.

### 2.3 Install Introduction

Put the CD into the CD driver, it will prop out an installation wizard, just click the relevant button and follow the clue to finish the installation, and then we can use the camera.

**Attention:** the first three buttons containing ‘Driver’ ‘Software’ and ‘Video Codec’ is necessary for the camera, and must be installed.
Select the relevant language, here the language means the installation language, after installation, you can change the language interface in the menu of the software.

**Driver:** Please link the camera with the PC before running the driver setup, if the system has not detected the camera, there will come out a dialog reminding you to insert
camera to the PC first, as the picture shows below. (1.3M pixel for an example)

![Camera-X1 - InstallShield Wizard](image)

In Windows XP system, there will be two warning dialogs when installing the driver, as the pictures below, just click ‘Continue Anyway’.

![Software Installation](image)

![Hardware Installation](image)

**Attention:**

Please choose the same USB2.0 port at the second use; otherwise you need to update your driver or reinstall the driver again to make the camera work normally.

**Software:** Click the software button to install the microscope image processing software – **ScopeImage 9.0**. Follow the clue to finish the installation.

**Video Codec:** Click the video codec button to install video encoding and decoding software, this is necessary for recording videos. Otherwise you will find you can not record or record error.

**Browse CD:** Click this button to browse the CD.

**Exit:** After the installation, click this button to exit and close the installation wizard.

**Other contents in the CD:**

- **DirectX9.0:** If your system is Windows 2000 operation, please install DirectX9.0, it is necessary.
Adobe Reader: If you can not read the user manual, please install the Adobe reader first, for the user manual is pdf format, and pdf files can only be read after you have installed the Adobe Reader. After installation, you can open the ‘User Manual.pdf’.

User Manual: Operation manual about how to operate the software.

2.4 Attention before Using

Before using the device, please read the following attention carefully.

★ This device supports operation system: Windows 2000/XP/Vista/Win7 32bit or 64bit. There are three parts "the driver, software and the video codec" in the CD must to be installed to make the camera work normally. Remember to link the camera with the PC first, then run the driver setup.

★ Error hint: “Cannot preview successfully.” Please check whether the camera has been linked with the PC, and whether the driver has been installed rightly. If not, please reinstall the driver.

★ Can not record or record error. Please check whether you have installed the "Video Codec" in the CD.

★ USB2.0 is a mandatory, not optional. This camera can not work on the computers with USB1.1 ports. In order to ensure the stability of the connection with the USB2.0 interfaces, please insert the plug into those interfaces in the back panel of the mainframe.

★ Please use the same USB2.0 port every time. Using on a different USB2.0 port may require to updating your driver again.

★ Please unplug the USB cable from the computer immediately after use. It will shorten the lifetime of the camera, sometimes may cause repair service if the camera is plugged in the computer all the time and you do not shut down the computer for a long time.

★ If you can not read the user manual, please install the Adobe reader in the CD first, then you can open the ‘User Manual.pdf’. And there detail information about operation.

★ The manufacturing and assembling of the device must be in the dust-free environment. Please don't attempt to open the camera case. There are no user serviceable parts inside. If you have any concerns about the device quality or the operation, please contact the dealer for detail information.
3 Workspace

Besides image windows, many other windows or user interface elements reside within the main window of ScopeImage 9.0. These include menu, toolbars, status bar and control windows providing additional information about the images or control of the camera.

3.1 Menu

The menu can be either docked or floating. Double-click its grip or caption bar to toggle between the two states. When the menu is docked, it can be docked to any of the four sides of the main window. Drag the grip or caption of the menu to adjust its position or to dock it to a particular side of the main window. The grip of the menu is the dot matrix at the left or top of the menu in docked state.

Video model menus

Image model menus

3.2 Tools Bar

ScopeImage 9.0 has four toolbars. Each toolbar can be either shown or hidden. When a toolbar is shown, it can be either docked or floating. Double-click its grip or caption to toggle between the two states. When a toolbar is docked, it can be docked to any of the four sides of the main window. Drag the grip or caption of a toolbar to adjust its position or to dock it to a particular side of the main window. The grip of a toolbar is the dot matrix at the left or top of the toolbar in docked state.

Floating state:
3.3 Camera Pane

Camera pane is where camera control commands are issued. It is further divided into three sub-panes (Video, Adjust and Capture) for specific aspects of the imaging process.

Sub-panes are shrinkable. To shrink a sub-pane, click the arrows at its top right corner. To expand a shrunk sub-pane, click again the arrows at this top right corner. The arrows at the top left corner of a sub-pane point upward in expanded state and downward in shrunk state. Camera pane also maintains a history of the panes shown.

If all the three sub-panes have been opened, the panel will be too long to display all the contents, so there will be two arrows at the top and the bottom of panel, put the mouse on it, the panel will expend upward or downward to display the other part contents.

Use the idler wheel of the mouse to extend the contents of the camera pane: click to select the camera pane, when it displays as yellow, roll the idler wheel to upward or downward display the contents of the camera pane.
Double click the title bar of the ‘Camera Pane’ (the yellow part of the image above), can turn to floating state, drag the grip or caption of the menu to adjust its position or to dock it to any of the four sides of the main window. Double click to return back, as the pictures shows below.

Camera pane can close, hide and display.

<table>
<thead>
<tr>
<th></th>
<th>Locking state</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Camera Pane</td>
<td></td>
</tr>
</tbody>
</table>

Hiding or Hanging state

When it is in hiding or hanging state, click the ‘Camera Pane’ or just put your mouse on it, the camera pane will display.
3.4 Auto focus pane (Optional)

The auto focus panel matches with our company’s automatic microscope.

The auto focus pane opens automatically when the software opens. You can also open it by the menu "View -> Auto focus".

**Note:** Please link the microscope with the computer by the RS232 cable before using the automatic microscope, otherwise the computer can not control the microscope, details about how to link and operate, please refer to the microscope user manual. If the computer does not have the RS232 interface, you need a USB-to-RS232 adapter.
4 Operation

ScopelImage 9.0 mainly divides into two parts operation, one is for the video operation, and the other one is for the image operation;
The Video mode menu: File, View, Window, Language, Help;
The Image mode menu: File, Edit, View, Image, Variant, Measure, Window, Language, Help;
“Alt + the first letter of the menu” can open the relevant menu.
Here we introduce you both the operation of the video and the image mode.

4.1 Video Mode

4.1.1 Video Preview

Video preview mode, the new preview button is gray.
When the preview window is closed, the video preview button is activated; Push the button can create a new preview window.

<table>
<thead>
<tr>
<th>New Preview</th>
<th>Push to new a new preview window; the equivalent command is the “File-&gt;New Preview” menu;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capture</td>
<td>Push to acquire an image based on the current camera settings and store into the disk;</td>
</tr>
<tr>
<td>Capture to field</td>
<td>Capture a frame to the field;</td>
</tr>
<tr>
<td>Record</td>
<td>Push to record ,the equivalent command is the record button on the camera pane;</td>
</tr>
<tr>
<td>Suitable preview</td>
<td>Suitable preview mode is fit to the window preview. This mode is best for finding the right field of view to capture. In this mode, the full field of view is visible, albeit possibly in a reduced resolution.</td>
</tr>
<tr>
<td>Real Preview</td>
<td>Real Preview mode is best for finding the right focus position. In real preview mode, maximal details are shown, although the field of view may be partially visible.</td>
</tr>
<tr>
<td>Full screen</td>
<td>Full screen display the active image.</td>
</tr>
<tr>
<td>Horizontal flip</td>
<td>Flip the active image by the Vertical axis, click to set or reset a flip state.</td>
</tr>
<tr>
<td>Vertical flip</td>
<td>Flip the active image by the horizontal axis, press to set or reset a flip state.</td>
</tr>
</tbody>
</table>
4.1.2 Video Control

The ‘Live’ and ‘Pause’ button can switch between active and static image

<table>
<thead>
<tr>
<th>Live (Video preview mode)</th>
<th>In video preview mode, the image is activating, we usually call it active image, it is fit for observing specimen or slice.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause (Freeze preview mode)</td>
<td>In freeze preview mode, the image has been frozen; it is fit for observing the detail information of the specimen.</td>
</tr>
</tbody>
</table>

Image flip

The image flip contains horizontal flip 🔄 and vertical flip 🔄.

- **Horizontal Flip:** Flip the active image by the Vertical axis.

![Original Image](image1.png) ![After click the Horizontal Flip button](image2.png)

- **Vertical Flip:** Flip the active image by the Horizontal axis.
**Horizontal and Vertical Flip:** Flip the active image by both of the Vertical and Horizontal axis.

**Light Source**
Select the light source of your microscope, LED or halogen lamp, it will display different color effect.

### 4.1.3 Color Adjust

The color adjust function contains the adjustment of the brightness, saturation, contrast, Gamma, sharpness, Red, Green, Blue, and also contain the auto white balance, recovery to the default setting and the color database.

<table>
<thead>
<tr>
<th>Adjust</th>
<th>Brightness: 14</th>
<th>20</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Saturation: 4</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>Contrast: 16</td>
<td>20</td>
</tr>
<tr>
<td>100</td>
<td>Gamma: 116</td>
<td>200</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Adjust</th>
<th>Red: 157</th>
<th>255</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Green: 106</td>
<td>255</td>
</tr>
<tr>
<td></td>
<td>Blue: 154</td>
<td>255</td>
</tr>
<tr>
<td>1</td>
<td>Exposure: 1</td>
<td>5</td>
</tr>
</tbody>
</table>
ScopeImage 9.0 image processing software

**Gamma**
Adjust the gamma of the camera. Gamma is an image quality enhancement function that offers a richer image by brightening the darker portions of the image without altering the brightness of the brighter portions.

**Red**
Increase the Red value of the active image.

**Green**
Increase the Green value of the active image.

**Blue**
Increase the Blue value of the active image.

[ ] **Auto Exposure**
Click ‘Auto Exposure’, the system will do auto exposure. Click again to manual exposure.

[ ] **Auto Whitebalance**
Click ‘Auto Whitebalance’, the system will do auto whitebalance. Click again to manual whitebalance.

**Recovery to the default setting.**

**The management of the database can allow you to store the current image parameters, which brings you great ease for adjusting the color.**

**The database of the color parameters**

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Bright</th>
<th>Sat...</th>
<th>Con...</th>
<th>Gamma</th>
<th>Red</th>
<th>Green</th>
<th>Blue</th>
<th>Exp...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>whb</td>
<td>10</td>
<td>5</td>
<td>14</td>
<td>170</td>
<td>131</td>
<td>152</td>
<td>1.34</td>
<td>-1</td>
</tr>
<tr>
<td>2</td>
<td>wh3</td>
<td>10</td>
<td>5</td>
<td>14</td>
<td>170</td>
<td>98</td>
<td>126</td>
<td>1.05</td>
<td>-3</td>
</tr>
<tr>
<td>3</td>
<td>whd</td>
<td>10</td>
<td>5</td>
<td>14</td>
<td>170</td>
<td>88</td>
<td>126</td>
<td>1.05</td>
<td>-3</td>
</tr>
</tbody>
</table>

**Apply**
Apply the select item to the active image.

**Add**
Add a new item to the active image.

**Del**
Delete the select item.

**Cancel**
Exit the ‘ColorParm’ dialog window.
4.1.4 Capture

1. **Record Video**

   ![Record Video button]

   Click the button to set the route and the file name.

Click the button to set the route and the file name.
Click the ‘Start’ button to begin to record.

Click the ‘Stop’ button to stop recording.

2, Capture

Select the resolution first, then click the “Capture” button to acquire an image based on the current camera settings and store it into the disk as jpg or bmp file format;

3, MultiCapture

ScopImage 9.0 is able to acquire a sequence of images automatically, and we call it multi-capture. Before acquire, we can set the wait time, interval time, amount, prefix, suffix, type, path and so on. After setting, a sequence of the image will be acquired according to the camera settings at the time when the acquisition action occurs.
<table>
<thead>
<tr>
<th><strong>Wait(s)</strong></th>
<th>The time to wait before beginning capture, in seconds</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Interval(s)</strong></td>
<td>Time interval, it means take image every 2 seconds, and can be referred as frequency.</td>
</tr>
<tr>
<td><strong>Images</strong></td>
<td>The amount to acquire.</td>
</tr>
<tr>
<td><strong>Prefix</strong></td>
<td>Set the prefix of the file name.</td>
</tr>
<tr>
<td><strong>Suffix</strong></td>
<td>The suffix of the file name. <strong>Attention:</strong> The prefix can be modified, but the suffix can not, it increases automatically while acquiring. If you have changed the storage folder, the suffix will change into 0 again, and increase from 0.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Set the image type of the images to be acquired.</td>
</tr>
<tr>
<td><strong>Folder</strong></td>
<td>Set the path of the image to be acquired <strong>Attention:</strong> In Windows Vista and Win 7 System, you’d better not set the capture as C:/, or you may can not save the images which is limited by user’s authority.</td>
</tr>
<tr>
<td><strong>MultiCapture</strong></td>
<td>Begin to multicapture.</td>
</tr>
<tr>
<td><strong>Stop</strong></td>
<td>Stop capture.</td>
</tr>
</tbody>
</table>

### 4.2 Auto focus pane (Optical)

1. Click “My Computer” on the desktop, right click the mouse, then click “Manage” to open the “Computer Management”. 
2. Check the communications port, as the picture shows below; here it is “COM1”

3. Open the software, choose COM1, and then click the “Open” button, the control pane functions as follows.
Please select the COM first, and then click the “Open” button to connect the microscope to the computer.

XY-axis platform control, click to move the platform around, and real-time display the X and Y coordinates.

Z-axis platform control, click to move the platform up and down.

Light brightness control, and real-time display.

Objective control and real-time display.

Choose “COM1”, then Click “Open”

Select to real-time Focus.

Click to find the focus.

Move the XYZ-axis to the specified location. Just put the values in the left box, then click the X, Y, or Z button to move the platform to the specified location.

Rang: X-axis 0-70000.0000um
Y-axis 0-50000.0000um
Z-axis 0-20000.0000um
4.3 Image Mode

4.3.1 Image Process

After we capture images, we can do image process, flip, measurement to the image

<table>
<thead>
<tr>
<th>Invert</th>
<th>Color reversal, can turn a positive image to a negative image, or turn a negative image back to a positive image. A negative image performing higher contrast and higher color saturation.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Average</td>
<td>Do average filter to the image, to clear the image noise;</td>
</tr>
<tr>
<td>Median</td>
<td>Do mediate filter to the image, the median filter is much better at preserving sharp edges than the average filter.</td>
</tr>
<tr>
<td>Sharpen</td>
<td>All digital photographs lose a certain amount of sharpness. That means that most photographs will look a bit blurred and their details won’t be as prominent. Basically, sharpening makes the edges of a photographed object appear more distinct.</td>
</tr>
<tr>
<td>Emboss</td>
<td>The Emboss filter makes a selection appear raised or stamped by suppressing the color within the selection and tracing its edges with black</td>
</tr>
<tr>
<td>Brightness</td>
<td>Change the brightness of the image;</td>
</tr>
<tr>
<td>Contrast</td>
<td>Change the brightness of the image;</td>
</tr>
<tr>
<td>Saturation</td>
<td>Change the brightness of the image;</td>
</tr>
</tbody>
</table>
4.3.2 Image Flip

The image flip operation is as the commands of the image flip menu.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Open an image, support bmp and jpg format;</td>
</tr>
<tr>
<td></td>
<td>Save the image, or the changes to the image;</td>
</tr>
<tr>
<td>100%</td>
<td>100%display the image;</td>
</tr>
<tr>
<td></td>
<td>Magnify display the image;</td>
</tr>
<tr>
<td></td>
<td>Reduce display the image;</td>
</tr>
<tr>
<td></td>
<td>Image flip by the vertical axis;</td>
</tr>
<tr>
<td></td>
<td>Image flip by the horizontal axis;</td>
</tr>
<tr>
<td></td>
<td>Retort 90 degree of the image;</td>
</tr>
<tr>
<td></td>
<td>Retort 180 degree of the image;</td>
</tr>
<tr>
<td></td>
<td>Retort 270 degree of the image;</td>
</tr>
<tr>
<td></td>
<td>Retort any angle of degree of the image;</td>
</tr>
</tbody>
</table>
Use the *Undo* command to reverse the most recent action that has modified the image. The equivalent command is the undo function under the Edit menu.

Use the *Redo* command to undo an Undo operation. The equivalent command is the redo function under the Edit menu.

### 4.3.3 Image Measurement

The system supports several measurement tools, such as the line, circle, rectangle, angle, and so on. The measurement result can be displayed in real-time on the image and can be merged into the image and saved for further use. The function is equivalent to the commands under the Measure menu.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Function Introduction</th>
</tr>
</thead>
<tbody>
<tr>
<td>🕐</td>
<td>Move</td>
<td>Move or adjust the objects, containing line, angle, circle, and rectangle.</td>
</tr>
<tr>
<td>🔎</td>
<td>Line</td>
<td>Add line objects. Each line object is defined by two endpoints. Press the left mouse button to specify one of the endpoints. Move the mouse to the other endpoint, while keeping the left mouse button pressed, to draw the line. Release the left mouse button to complete the line drawing. The above procedure may be repeated to create more lines. A line object has two resizing handles, located at the two endpoints. The length of the line will appear over the image at the same time.</td>
</tr>
<tr>
<td>🔥</td>
<td>Angle</td>
<td>Use the <em>Angle</em> command to measure angles. Click to specify three controlling points. The angle made by the line passing through the 1st and the 2nd point, and the line passing the 2nd and 3rd point, will be measured. The degree of the angle will appear over the image at the same time.</td>
</tr>
<tr>
<td></td>
<td>same time.</td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td><strong>Circle</strong></td>
<td>Click to specify two controlling points. The 1st point as the center of the circle, move the mouse to the 2nd point while keeping left mouse button pressed to draw the circle. Release left mouse button to complete the creation of this circle. The line between the 1st and the 2nd point as the radius. Repeat the procedure above to add more circle objects. Drag the handles at the corners to adjust the size of the circle simultaneously. Drag anywhere else within the circle to move the circle object. The area and radius of the circle will appear over the image at the same time.</td>
<td></td>
</tr>
<tr>
<td><strong>Rectangle</strong></td>
<td>Each rectangle is specified by two diagonal vertices. Press down left mouse button to specify one vertex. Move the mouse to the other vertex while keeping left mouse button pressed to draw the rectangle. Release left mouse button to complete the creation of this rectangle. Repeat the procedure above to add more rectangle objects. A rectangle object has four resizing handles. Drag the handles at the four corners to adjust width and height of the rectangle simultaneously. Drag anywhere else within the rectangle to move the rectangle object. The area of the rectangle will appear over the image at the same time.</td>
<td></td>
</tr>
<tr>
<td><strong>Polygon</strong></td>
<td>Use the <em>Polygon</em> command to measure the area of a polygon. Click to specify the vertices of the polygon. After the last vertex has been specified, double-click left button to start (and to complete) the measurement.</td>
<td></td>
</tr>
<tr>
<td><strong>Text Annotation</strong></td>
<td>Use the <em>Text Annotation</em> command to add the text on the image. And click the left button will specify the location of the text. Note: The text annotation can only be deleted, it can not be moved.</td>
<td></td>
</tr>
<tr>
<td><strong>Delete one</strong></td>
<td>Use the <em>Delete one</em> command to remove the selected object on the image.</td>
<td></td>
</tr>
<tr>
<td><strong>Delete All</strong></td>
<td>Use the <em>Delete All</em> command to clear all the objects on the image.</td>
<td></td>
</tr>
<tr>
<td><strong>Generate measurement data</strong></td>
<td>This command will clear background image, and generate an image that just will the measurement marker.</td>
<td></td>
</tr>
<tr>
<td><strong>Calibration</strong></td>
<td>The system micrometer consists of the sampling intervals in horizontal and vertical directions. In the calibration process</td>
<td></td>
</tr>
</tbody>
</table>
both of the two sampling intervals should be calculated. Details please see chapter 4.2.4 Image Calibration. IMPORTANT!!!
Calibration should be done on an image before measuring.

<table>
<thead>
<tr>
<th>Show/hide calibration ruler</th>
<th>Click this button to show the calibration ruler, click again to hide it.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure setting</td>
<td>Set the color of the coordinate, line, adjuster and text,</td>
</tr>
</tbody>
</table>

![Image of calibration tool settings](image)

4.3.4 Image Calibration

The system micrometer consists of the sampling intervals in horizontal and vertical directions. In the calibration process both of the two sampling intervals should be calculated as there’s tolerance error between the two directions.

Here shows the calibration under $10 \times$ object lens for an example.

1. For the calibration can only do to the static image, we should take a picture first. First, put the 0.1mm micro-ruler in the video window, adjust to display clear, then turn around the camera, make the active images parallel to the horizontal line, and click the button on the tools bar to capture a frame to the field, as the picture shows below.
2. In the image field, click the button 🔄 to move the scale, you can also click the 🔍 or 🔩 button to magnify or reduce the current image in order to convenient the calibration. Here shows the calibration result when it is reduced to 50%.

3. Click the icon 🕒 to display the calibration scale, click the icon 🔄 to move the scale to the right position, confirm the begin point and the end point, as the picture shows below.
4. Click the calibration icon to set the ‘X-Ruler Unit’. Input the actual length 100um, and click the button ‘Save As’ to save the calibration for X axis.

5. Click input a calibration file name on the box, and click ‘Save’ to save it, then click ‘OK’ to exit, now we have finished the calibration for the X axis.
The calibration for the Y axis is as follows.
6. The calibration for the Y axis is similar to the X axis. First, we turn around the camera to make the micro ruler vertical to the horizontal line, click the button on the tools bar to capture a frame to the field, as the picture shows below.

7. Click the calibration icon on the tools bar, then click ‘Lode’ button, and select the file of calibration for X axis we have just done, click ‘Open’.
8. Now we keep the X axis don’t move, and do calibration to the Y axis, move the scale to the right position, confirm the begin and the end point;
9. Click the icon $\mathbb{I}$, input the actual length in the “Y-Ruler Unit”, and click “save” to save the calibration result for further using. Click “OK” to exit, now we have finished the calibration for both X axis and Y axis, and we can find that there is a little difference between them.
Check the calibration result:

The calibration has been finished, now we check it. Use the micro ruler, and capture a frame to the field, load the calibrations we have just done, and do line measure, as the picture below:

We can find the measurement is close to the actual length, take the tolerance error for account, the measurement result is right.

4.4 Full Screen Mode

As we know, it is very convenient to preview the live image in the full screen mode. Double click the live image or click the button on the tools bar can enter into the full screen mode, double click or click the button “Close Full Screen” to exit full screen mode.
5 Trouble Shooting

5.1 Problem and Solution

Problem: When open the software, the computer displays an error hint as the picture shows below,

Solution: Please check whether the camera has been linked with the PC, and whether the driver has been installed rightly. If not, please reinstall the driver or update the driver. And remember to use the same USB2.0 port every time, especially in Windows XP and 2000 system. See the next chapter.

Problem: Can not record or record error.

Solution: Please check whether you have installed the ‘Video Codec’ in the CD.

Problem: Can not read the user manual.
Solution: Please install the Adobe reader in the CD first, and then you can open the 'User Manual.pdf'. There are detail information about operation.

5.2 How to update driver

When launching the software ‘ScopeImage9.0’ on the desktop, the system displays an error hint as follows:

The most problem is:

1. The camera has not connected with the PC, please link it with the PC, and then run the software.

2. Users have changed the USB port and the driver has not reinstalled, please reinstall the driver or update the driver.

Here shows how to update the driver:

(1) In Windows XP system

1. Go to Control Panel, as follows:
Select Device Manager.

The "USB Video Device" is the default driver of the system; we need to install the special driver for the camera itself.

Right click ‘USB Video Device’, click ‘Update Driver…’, comes out ‘Found New Hardware Wizard’ dialog, please choose “this time only”, then click next.
Click 'Next'

Choose 'Install from a list or specific location (Advanced)', click next.
Choose 'Don’t search. I will choose the driver to install.'

Choose ‘Camera-X1’, Click ‘Next’.
Hardware Installation, click ‘Continue Anyway’.

Hardware Update Wizard

Completing the Hardware Update Wizard

The wizard has finished installing the software for:

Camera-X1

Click Finish to close the wizard.

Click ‘Finish’. Hardware installation has been finished.

You'd better restart your computer to make the new device work rightly. And you can check the “Imaging Devices” in “Device Manager / Hardware”. When it displays as “Camera-X1”, then you can use the camera to preview the images.